Thermal Printer and Thunderbird Setup Instructions for
TCC Libraries

1. Download and install the Advanced Printer Driver v5.10 for the TM-T88VI Thermal Printer
1. Connect the printer to the computer using the provided USB cable.

2.1

o . [P
connects to the printer. ——— connects to the computer.
r:p:a Type-A

2. https://epson.com/Support/Point-of-Sale/OmniLink-Printers/Epson-TM-T88VI/s/SPT_C31CE94061

& ¢ ® ® © & https://epson.com/Support/Point-of-Sale/OmniLink-Printers/Epson-TM-T88VI/s/SPT_C31CE9 B e P d mw o =

A

Drivers —

Epson OPOS ADK for .NET v1.12.28E +
10/05/18 ‘ 36.9 MB ‘ OPOS_ADK_DOTNET_11228.exe
Epson ePOS SDK for Android v2.9.2 +
% Download »
10/03/18 ‘ 46.4 MB ‘ ePOS_SDK_Android_v2.9.2.zip
Epson ePOS SDK for iOS v2.9.2 +
Download »
10/03/18 ‘ 167 MB ‘ ePOS_SDK_iOS_v2.9.2.zip
OPOS ADK v2.80E R14 +
10/03/18 ‘ 30.4 MB ‘ OPOS_ADK_280ER14.exe
Advanced Printer Driver v5.10 +
09/13/18 ‘ 70.4 MB ‘ TM-T88VI_APD_5.10.exe

3. Open the Downloads Folder and find the downloaded driver.

3| v s | Downloads — O X
Home Share View o
<« v 4 & > ThisPC > Downloads v U  Search Downloads P

~ Name Date modified Type Size
v 5 Quick access
1 2 . 1 1 2
m Desktop a Thunderbird Setup 60.3.2.exe 12/3/2018 9:27 AM  Application 31,177 KB
(®) TM-T88VI_APD_5.10.exe 1/16/2019 5:46 AM  Application 72,192 KB

# Downloads

|5 Documents

o LV
2 items % =




4. Right-click and select Run as administrator.

Name

a Thunderbird Setup 60.3.2.exe
@ T™M-T88VI_APD_5.10.¢*

<
5. Click OK to continue.

N

Date modified

A/4£0010 L. AL

12/3/2018 9:27 AM

Open

wmn as administrator

5 K

Troubleshoot compatibility
Pin to Start

7-Zip

CRC SHA

Edit with Notepad++
Share

A%

Give access to
Cisco AMP For Endpoints
Pin to taskbar

Restore previous versions

AV

Send to

Cut
Copy

Create shortcut

Delete

M

Type

Application
Application

Epson Installer

Version 5.10 for Windows.
This file self-extracts to the following location:
c\epson\TM-T88VI_APD_5.10

Click OK to continue.

“ This file contains the Epson TM-T88VI Advanced Printer Driver

OK

Cancel

Size

72,



6. Wait while the installer unpacks.

@) Setup - EPSON Driver Package

Installing

Please wait while Setup installs the Epson files on your computer.

Extracting files...
C:\epson\TM-T88VI_APD_5.10\APD_510_T88VI.exe

Done: 88.83 %
Elapsed: 00:00:02
Remaining: 00:00:00

Cancel




7. In the newly created folder that opens (C:\epson\TM-T88VI_APD_5.10), right-click APD_510_T88VI.exe
and select Run as Administrator.

Name Date modified Type Size
g@ APD_510_T88VI.ex OHNAN10 610 AM Application 58,2
@ APDS5 _Install_en_rey Open AM Adobe Acrobat Docu... 2,¢
B® APD5_MAN _T88VI_ %Run as administrator AM  Application 18,(
| APD5_README_EN Troubleshoot compatibility AM  Text Document
Pin to Start
7-Zip >
CRC SHA >
g Edit with Notepad++
& Share
* Cisco AMP For Endpoints >
Pin to taskbar

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties >




8. Click Next.
B EPSON Advanced Printer Driver Ver.5 X

Check Installation

This program will install EPSON Advanced Printer Driver for TM-T88VI Ver.5 on your computer.
We recommend dosing all Windows applications before running this setup program.

Click "Next" to start installing.

Warning

When using this product with any of the following programs on the same PC, use the versions listed A
below. When using printer sharing, be sure to check the version installed on the dient PC before
use.

EPSON Advanced Printer Driver 4 Ver4.54 or later
EPSON OPOS ADK Ver2.68 or later

EPSON OPOS ADK for .NET Ver1.11.20 or later
EPSON JavaPOS ADK Ver1.11.20 or later

EpsonNet Simple Viewer Ver 2 30 or later
TM Virtual Port Driver Ver7. 0a or later

When connecting the customer display to the printer, refer to the EPSON Advanced Printer Driver v

Cancel " Next>



9. Select Agree and click Install.

10.

o/ EPSON Advanced Printer Driver Ver.5

License Agreement

Please read the License Agreement carefully. Click [Agree] to accept the terms and conditions of this
License Agreement, and then dick "Install”, Otherwise, dick "Back".

SEIKO EPSON CORPORATION
SOFTWARE LICENSE AGREEMENT

IMPORTANT! READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY. The computer software
product, fontware, typefaces and/or data, induding any accompanying explanatory written
materials (the "Software”) should only be installed or used by the Licensee ("you”) on the condition
you agree with SEIKO EPSON CORPORATION ("EPSON") to the terms and conditions set forth in this
Agreement. By installing or using the Software, you are representing to agree all the terms and
conditions set forth in this Agreement. You should read this Agreement carefully before installing or
using the Software. If you do not agree with the terms and conditions of this Agreement, you are
not permitted to install or use the Software.

1. License. EPSON and its suppliers grant you a personal, nonexdusive, royalty-free, non-

v

(O Disagree ©Agr$e

Wait for the installer to complete.

EPSON Advanced Printer Driver Ver.5

Instaling, please wait.
[

Installing the EPSON Port Communication Service ...




11. Click Next.

EPSON Advanced Printer Driver Ver.5

Printer Registration

The printer is ready for registration.

Click "Next" to register the printer.

Connect the printer to your computer and turn the printer power on.

Next >




12. Change Port Type to USB and check the Set as Default Printer checkbox.

'\ Register, Change and Delete EPSON TM Printer
File
1. Select Printer

Name

{New Printer>

Model

Status

2. Printer
Model EPSON TM-T88VI Receipt v

Name
Receipth
[/ |EPSON TM-T88VI Receipt

Attention:

WWhen connecting the customer display to
the printer, refer to the EPSON Advanced
Printer Driver Ver 5 for DM-D Ihstall
Manual.

3. Communication Settings

Port Type COM

Port ’OOMS:
Baud Rate 38400
Parity 'NONE
Stop Bits ’ 1

Flow Control ’ Hardware
Data Bits ‘B

4. Apply

[(]Set as Default Printer

Save Settings

Copy Delete

Test Print

5. Complete

Next




13. Click Save Settings.

'\ Register, Change and Delete EPSON TM Printer
File
1. Select Printer
Name Model Status
<{New Printer>
2. Printer 3. Communication Settings 4. Apply
Madel EPSON TM-T88VI Receipl + ‘ )
Port Type UsB v [ Set as Default Printer
Name
Receipt Port ’ Auto setup -
™ lEPSON TM-T88VI Receipt | Save Settings %
Copy Delete
Test Print
Attention: 5. Complete
WWhen connecting the customer display to
the printer, refer to the EPSON Advanced
:’nrinterl Driver Ver5 for DM-D Install Next
anual.




14. Click Yes to perform a test print.

X’ Register, Change and Delete EPSON TM Printer

File
1. Select Printer
Name Model Status
<{New Printer>
5@ EPSON TM-T88VI Receipt EPSON TM-T88VI Receipth Ihstalled
PrinterReg
2. Printer : Printer settings successfully saved. 4. Apply
Model EPSON TM-T88VI Receipl Do you want to perform a test print?
[ Set as Default Printer
Name
EPSON TM-T88VI Receipt | [ ] o Save Settings lko

\ Copy Delete

Test Print ‘

5. Complete

Attention:

WWhen connecting the customer display to
Next

|

the printer, refer to the EPSON Advanced
Printer Driver Ver 5 for DM-D Ihstall
Manual.




15. Click Next.

|

'\ Register, Change and Delete EPSON TM Printer
File
1. Select Printer
Name Model Status
<{New Printer>
5@ EPSON TM-T88VI Receipt EPSON TM-T88VI Receipt5 Installed
2. Printer 3. Communication Settings 4. Apply
Madel EPSON TM-T88VI Receipl )
Port Type use v [F1Set as Default Printer
Name ! '
Port ESDPRTO01 v
EPSON TM-T88VI Receipt ' Save Settines
Copy ’ ‘ Delete
Test Print
Attention: 5. Complete
WWhen connecting the customer display to
the printer, refer to the EPSON Advanced
'I;‘rinterl Driver Ver5 for DM-D Ihstall Next
anual.




16. Click Close.
! EPSON Advanced Printer Driver Ver.5

Installation Complete.

EPSON Advanced Printer Driver for TM-T88VI Ver. 5 has been successfully installed.




2. Download and install Thunderbird Email Client from Mozilla
1. https://www.thunderbird.net/en-US/

2. Set up the email account:

1. Open Thunderbird and enter the account information into the setup screen, then click Continue.

Home

v CJchat /R Address Book

Q Search <Ctrl+K>

= Events

o X
< > X

. 1 5 Tue < O >
Thunderbird Jan2019  CW3
53 New Event
Accounts Set Up an Existing Email Account X Today
Tomorrow

(“4 Setup anaccount:

= Email &) cChat !

Create a new calendar

vour name: |

‘ Your name, as shown to others

Email address: l-@tccdedu

‘ Your existing email address

Password: l oooo.o-oaoaoo.|

Remember password

Upcoming (5 days)

Get a new email address... Continue Cancel
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X
T N (3 Today Pane v
2. The information will be incorrect. This is expected.
Home ‘ — [} X
ot Me ite v CJcChat R Address Book v ( er | Q Search <Ctrl+K> = | Events < > X
. Tue < 0>
Thunderbird 15

a

(

Jan2019 CW3

'E';‘, New Event

Set Up an Existing Email Account % X
Your name: _ Your name, as shown to others days)
Email address: -@tccd.edu Your existing email address
Password: ‘ eeccccccccccee ‘
Remember password
(%, Thunderbird failed to find the settings for your email account.
Server hostname Port SSL Authentication
Incoming: ' IMAP  V ‘ tced.edu ‘ ’ Auto v | |Autodetect v | Autodetect K2
Outgoing: SMTP ‘ .tced.edu v ‘ ’ Auto v | Autodetect v Autodetect e
Username: - incoming: | [ | NRRREI Outgoing: I
Get a new email address...  Advanced config Re-test Done Cancel
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X

(18) Today Pane v
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3. Enter the following using your campus-specific settings.

»

Home ‘ - O %
Get Messag v [Jchat R Address Book Tag v Quick Filter | Q Search <Ctrl+K> =  Events < > X
. 1 5 Tue <O >
Thunderbird 2019 W3

ﬁ; New Event

(
Set Up an Existing Email Account X
Your name: _ Your name, as shown to others days)
Email address: -@tccd.edu Your existing email address
Password: ‘ XTI Y Y YY YY) ‘
Remember password
(%, Thunderbird failed to find the settings for your email account.
Server hostname Port SSL Authentication

Incoming: IMAP v ‘ outlook.office365.com ‘ ’ 993 v ‘ SSL/TLS v | Autodetect &z

Outgoing: SMTP ‘ outlook.office365.com v ‘ ’ 587 v | STARTTLS v | Autodetect K2

Username: Incoming: Outgoing:

Get a new email address...  Advanced config Re-test Done Cancel

Learn more Disable Keep X

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

(18) Today Pane v

L

v CJchat /R Address Book Tag Vv Quick Filter | Q Search <Ctrl+K>

Thunderbird

L
Click Re-test. If there are no errors, click Done.
Home — O X
= | Events < > X

15Tue < 0>

Jan2019 CW3

'E"é New Event

(
Set Up an Existing Email Account X
Your name: _ Your name, as shown to others days)
Email address: @tccd.edu Your existing email address
Password: ’ ecccccccccee ‘
Remember password
The following settings were found by probing the given server
Server hostname Port SSL Authentication
Incoming: | IMAP he ‘ outlook.office365.com ‘ l 993 v ‘ SSL/TLS ¥ Normal password 7
Outgoing: SMTP outlook.office365.com v ‘ l 587 v | STARTTLS ¥ Normal password &2
Username: Incoming: _ Outgoing: _
Get a new email address... | Advanced config Done Cancel
Learn more Disable Keep X

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

[E] Today Pane v
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5. Click Set as Default.

Home
tid Get Me s v /)
v Sk @tccd.edu
& Inbox

~ M Local Folders
= Trash
* Outbox

— O X

O Chat

& Address

Book Tag v Quick Filter O\ Search <Ctrl+K>

Thunderbird

Accounts

(“4 Setup anaccount:

=1 Email

|- Createane

=) Chat__ ') Newsaroups Feeds

Use Thunderbird as the default client for:
E-Mail A
[] Newsgroups

Feeds v

Always perform this check when starting

Thunderbird
Set as Default | | Skip Integration

System Integration X

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

< > X

15Tue < 0>

Jan2019 CW3

Events

ﬁ; New Event

v Today
Tomorrow

Upcoming (5 days)

Learn more Disable Keep X
L (i8) Today Pane v
6. Click Options icon >> Add-ons >> Add-ons.
Home ® B = X
” Write v G Chat & Address Book ‘ O Tag v ¥ QuickFilter Q search <Ctrl+K> = | Events < > x
v I tc<d.cdu New Message Activity Manager
% Inbox Thunderbird Attachments Message Filters >
=
- Trash Edit > Add-ons% 5
v 8 Local Folders Find > — >
- Trash Accounts Print... Lightning
*, Outbox File >
- (“w» Setupanaccount: Save As > - N
Folders > Go N
< Email HChat ) Newsgroups Feeds Empty Trash Messa 8
ge
— Events and Tasks >
|| Create a new calendar Tools 5
O it Help >
@® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X

L]

(f3) Today Pane v
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7. Click See all.

~ Home [ 2 Add-ons Manager

+*
& Get Add-ons

*. Extensions

‘/ Themes

il Plugins

x|

BB - o x

What are Add-ons?

Add-ons are applications that let you personalize
Thunderbird with extra functionality or style. Try a
time-saving sidebar, a weather notifier, or a themed
look to make Thunderbird your own.

Featured Add-ons

A new Thunderbird

o)
TT DeepDark
Simple and smooth

CardBook

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

"8 https://addons.thund:
8. Search for PrintingTools.

bird.net/en-US/thunderbird,

~ Home

Add-ons Manager

?sor

X | % Up & Coming Extensions = X

& Add-ons

EXTENSIONS THEMES COLLECTIONS MORE...

Welcome to Thunderbird Add-ons. Add extra features and styles to make Thunderbird your own

Mail Redirect
Allow to redirect (a.k.a.

Thanks for using
Thunderbird and
supporting Mozilla's
mission!

Add-ons downloaded:
4,294,967,295

Learn More

ng

@ Provider fo

:Bg} Provider for Ex... »

w Paranoia >

Seeall
Iy

&2 ThbSync >
“ Duplicate Cont... )
Featured See all
Themes

= e

Airmail

< > X

15Tue < 0>

Jan2019 CW3

Events

E8 New Event

v Today
> Tomorrow

> Upcoming (5 days)

v

‘Leam more Disable ‘ ‘ Keep X
(48) Today Pane v

& 6B - X

Register or Login | Other Applications

>

Q_ printingTools| T

Search add-ons for "PrintingTools"

ag PrintingTools

EXPLORE
Featured
Most Popular

Top Rated

S

n
CATEGORIES

Appearance and Customiz...
Calendar and Date/Time
Chatand IM

Contacts

Folders and Filters
Import/Export

Language Support

Sortby: Featured | Most Users

Up & Coming Extensions

Top Rated | Newest

LaTeX It!
This addons allows you to write LaTeX expressions in
your emails such as $xA2$ or $$\sum_{x=0Ninfty$$ and
have them all replaced by a PNG image with the
corresponding formula inside.

(31) - 372 users.

Open Google Calendar EIEIES
Adds the Google Calendar web interface in a new
Thunderbird tab. Creating and viewing events works like
in a browser (Firefox, Chrome, ...)

(12)- 2,023 users

® Thunderbird now contains calendaring ft

the Lightning

Up & Coming | More ~

N Subscribe

+ Add to Thunderbird

4+ Add to Thunderbird

< > X

15Tue < 0>

Jan2019 CW3

Events

@ New Event

v Today
> Tomorrow

> Upcoming (5 days)

v

Learn more

Disable ‘ ‘ Keep X

Today Pane v



9. Click Add to Thunderbird.

~ Home *- Add-ons Manager

X ¥ PrintingTools :: Search :: Adc X

& Add-ons

EXTENSIONS THEMES COLLECTIONS MORE...

Filter Results

CATEGORY
All Add-ons

WORKS WITH

Thunderbird 60.4
Windows

TAG
All Tags

5 matching results

Search Results for "PrintingTools"

Sortby: Relevance = Most Users | Top Rated | Newest | More

% PrintingTools EEMIELEIE

Adds some options to print messages and addressbooks
(27) - 33,166 users

@ 'mportExportTools

Adds some tools to import and export folders and messages
(202) - 457,433 users

4 Rise of the Tools
=== Moves the toolbar back above the tabbar.
(57)-2,747 users

i Header Tools Lite

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

"8  hitps://addons.thunderbird

loads/latest/printi Is/addon-330424-latest xpi?src=search

10. Click Install Now.

Register or Login | Other Applications ~ Events

EXITN—

< > X

15 Tue < 0> _
Jan2019 CW 3

aNewEvenl

v Today

> Tomorrow

> Upcoming (5 days)

4 Addto
@ Thunderbird

7

‘ Learn more Disable ‘ ‘ Keep X

(18) Today Pane v

Software Installation

Install add-ons only from authors whom you trust.

Malicious software can damage your computer or violate your privacy.

You have asked to install the following item:

X

@t

PrintingTools
https://addons.thunderbird.net/thunderbird/downloads/latest/printingtools/addon-3

Install Now Cancel




11. Click Restart Now.

~ Home | *- Add-ons Manager X * PrintingTools :: Search :: Adc X

.
5 B - X

ﬂ- PrintingTools will be installed after you restart Thunderbird.

[Restothow] X)) Bvems < > x

[
Register or Login | Other Applicati.. .~ 15 Tue < O >

Jan2019 CW3

/ +—
@ Add-ons o R

EXTENSIONS THEMES COLLECTIONS MORE...

Tomorrow

Upcoming (5 days)

Filter Results Search Results for "PrintingTools"
CATEGORY Sort by: Relevance | Most Users | Top Rated | Newest | More ~
All Add-ons
inti
WORKS WITH % PrlntlngToqu : + Addto
Adds some options to print messages and addressbooks Thunderbird
Thunderbird 60.4
X [z B R =T S —
Windows
7w e L ee————— r ST ITITITITT
@ !'mportExportTools [EIEEID ; + Addto :
All Tags Adds some tools to import and export folders and messages | Thunderbird |
5 matching results (202)- 457,433 users
. T ITITIITS
4 Rise of the Tools | AL A |
W= Moves the toolbar back above the tabbar. | Thunderbird ‘
(57) - 2,747 users
v
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable ‘ ‘ Keep X
L (i) Today Pane v
12. Click Options icon >> Add-ons >> PrintingTools.
Home \ &8 - X
[ Get Messages v /" Wiite v CJ Chat & Address Book ‘ O Tag v ¥ QuickFilter Q_ search <Ctrl+K> Events < > X
v I @tccd.edu New Message > Activity Manager
& inbox Thunderbird Mail - {J R @tccd.edu Attachments S Messagefiters
' Trash i
ras Edit ’ ’7 Add-ons >
Local Folders o Find >
Email n ightni >
- Trash Print... Lightning
>
® Outbox [, Read messages Save As N Vo .
Folders >
-/ Write a new message Go >
L;-Jl 9 Empty Trash NMezege N
Events and Tasks >
l Accounts Tools >
s .
. . . Exit Hel >
 View settings for this account O & —
23 9
(“» Setup an account:
< Email HChat ' Newsgroups | Feeds
[T] Create a new calendar
[ Advanced Features
) search messages
<+ Manage message filters
A Manage folder subscriptions
o
v
® Thunderbird now contains calendaring functionality by i ing the Lightning Learn more Disable ‘ ‘ Keep X

L

Today Pane v
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13. Set up PrintingTools as pictured below (Note: the Headers order tab is not displayed here because we
are disabling headers).

PrintingTools

Miscellaneous Style Headers order Global printing options

Options for messages printing
Date format: (®) short (native) () long and localized O long UTC
Enable customized view of the attachments' list
[]Add a filetype icon
[_]Add p7m and vCard attachments
[_]Set a border around the headers
Hide the headers
[ ] Hide always extended headers
Hide the images
[] Resize the images too large

[ ] Add received date

[_] Truncate the headers' lines longer than about | 80 chars.

Maximum width for text: |90

Hide inline attachments

Add before headers: (®) Nothing () User name ()
[ ] Add folder name

[_]Print just selection, when it exists

Align the headers

Show the options button in the preview window

OK Cancel




PrintingTools

Miscellaneous Style Headers order Global printing options

Use black as base color for text
Use fonts with a size in pixel of | Microsoft Sans Serif ¥ withsize 10 Vv

(® for body message () just for headers

[ JUsea style for quoted text Color: Bl s 0

OK Cancel




PrintingTools

Miscellaneous Style Headers order Global [tgnting options

Print without the dialog window
Hide the print progress bar

14. Click OK to close the PrintingTools options window.

oK

Cancel



15. Click Options icon >> Add-ons >> Add-ons (again).

Home ® B = X
7 Get Messages v /" Write v [ Chat & Address Book ‘ ® Tag v ¥ QuickFilter Q_ search <Ctrl+K> = | Events < > x
v It @tccd.edu New Message Activity Manager
& Inbox Thunderbird Attachments Message Filters >
- Trash Edit > Addfons% N
v 8 Local Folders Find > — >
- Trash Accounts Print... Lightning
*, Outbox File >
= (“a Setup an account: Save As > — 8
Folders > o 5
< Email HChat ) Newsgroups Feeds Empty Trash R s
— Events and Tasks >
|| Create a new calendar Tools 5
O it Help >
@® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X
L] (i) Today Pane v
16. Click See all (again).
Home ‘ 4 Add-ons Manager X ‘ (5] = X
. Events < > X
Thanks for using
- ? Thunderbird and < >
X What are Add-ons? T rlla's 15 Tue <©
$> Get Add-ons Jan2019  CW3

*. Extensions

7 Themes

»

il Plugins

look to make Thunderbird your own.

Featured Add-ons

. O]
CardBook TT DeepDark

A new Thunderbird Simple and smooth

® Thunderbird now contains calendaring functionality by integrating the Lightning extension.

"8 https:/addons.thunderbird.net/en-US/thunderbird/extensions/?sort=hotness

Add-ons are applications that let you personalize
Thunderbird with extra functionality or style. Try a
time-saving sidebar, a weather notifier, or a themed

<

Mail Redirect

Allow to redirect (a.k.a.

. EI Learn More

mission!

Add-ons downloaded:
4,294,967,295

New Event

v Today
Tomorrow

Upcoming (5 days)

Up & Co

® Provider fo

E/g Provider for Ex... )

@ Paranoia >

ng See all

sl

& TbSync >
% Duplicate Cont... )
Featured See all
Themes
Airmail o
Learn more Disable Keep X

Today Pane v
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17. Search for FiltaQuilla.

Add-ons Manager X | % Up & Coming Extensions =/ X ® E - X

Home

Register or Login | Other Applications A‘ Events < > X

15Tue < 0>

Jan2019 CW3

@ Add-ons Ca—

E8 New Event
EXTENSIONS THEMES COLLECTIONS MORE...
v Today
. . Search add-ons for “filta" > Tomorrow
EXPLORE Up & Coming Extensions ;
. . > Upcoming (5 days)
= FiltaQuilla
Featured @
Most Popular Sortby: Featured | Most Users | Top Rated | Newest = Up & Coming = More ~ N Subscribe
Top Rated
(5 LaTeX It! + Add to Thunderbird
"™ This addons all to write LaTeX jons i
CATEGORIES is addons allows you to write LaTeX expressions in
your emails such as $x2$ or $$\sum_{x=0Ninfty$$ and
Appearance and Customiz... have them all replaced by a PNG image with the
. corresponding formula inside.
Calendar and Date/Time (31)- 372 users
Chatand IM
Contacts
Open Google Calendar + Add to Thunderbird
Folders and Filters Adds the Google Calendar web interface in a new
Import/Export Thunderbird tab. Creating and viewing events works like
in a browser (Firefox, Chrome, ...)
Language Support (12) - 2,023 users
Message Composition
Message and News Reading :
& Provider for CalDAV & CardDAV B
Miscellaneous This extension adds support for CalDAV & CardDAV
arcaunte ta tha Thindarhird Cume manaaar FThCy et v
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. ‘ Learn more Disable ‘ ‘ Keep X
8 https://add: hunderbird.net/en-US/thunderbird/addon/fil illa/?src=ss [E] Today Pane v
18. Click Add to Thunderbird.
~ Home Add-ons Manager X | % FiltaQuilla : Add-ons for Th: X ® B - X
Register or Login | Other Applications A‘ Events < > X

‘15Tue <o>

Jan2019 CW3

Q search for add-ons 9
@ New Event
EXTENSIONS THEMES COLLECTIONS MORE...
v Today
. R % % k% > Tomorrow
IRES RESTART .
FiltaQuilla ... e 76 user reviews > Upcoming (5 days)
by R Kent James, Realraven (Axel Grude! 9,249 users
Adds many new mail filter actions - launch a file, suppress notification, remove star
or tag, mark replied or unread, copy as "read", append text to subject.
#+ Addto Thunderbird = A Permissions
v
® Thunderbird now contains calendaring functionality by i ing the Lightning i Learn more Disable ‘ Keep X

%@ https//addons.thunderbird.net/thunderbird/downloads/latest/filtaquilla/addon-10052-latest xpiZsrc=ss Today Pane v




19. Click Install Now.

||, Home Add-ons Manager X * FiltaQuilla :: Add-ons for Th X @ @ - X

Add-ons

EXTENSIONS THEMES COLLECTIONS MORE...

@ ‘ Events < > X

15Tue < 0>

Jan2019 CW3

E8 New Event

v Today

> Tomorrow

i Install add-ons only from authors whom you trust. eviews > Upcoming (5 days)

Software Installation
FiltaQuilla .. [reatiresse
by R Kent James, Realraven (Ax|

L]

Malicious software can damage your computer or violate your privacy.
Adds many new mail filter |

or tag, mark replied or unr VR

+ Add to Thunderbird FiltaQuilla
B https://add: [Sund

.net/thunderbird/dowr

Cancel

‘ »
o) e ==
v
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable ‘ ‘ Keep X
%8 httpsy//addons.thunderbird.net/thunderbird/downloads/latest/filtaquilla/addon-10052-latest xpi?src=ss (3) Today Pane v
20. Click Restart Now.
| Home | 2§ Add-ons Manager X | % FiltaQuilla  Add-ons for Th X s E| = X
a- FiltaQuilla will be installed after you restart Thunderbird. X Events < > X
S
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@ New Event

& Add-ons 5

EXTENSIONS THEMES COLLECTIONS MORE...

v Today

> Tomorrow
S > Upcoming (5 days)
FiltaQuilla .. [Requiresrestass 76 user reviews

by R Kent James, Realraven (Axel Grude! 9,249 users

Adds many new mail filter actions - launch a file, suppress notification, remove star
or tag, mark replied or unread, copy as "read", append text to subject.

4+ Add to Thunderbird A\ Permissions

»

v
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21. Click Options icon >> Add-ons >> FiltaQuilla.

Home ‘ ® B - X
[ Get Messages v /" Wiite v CJ Chat &R Address Book Tag v Quick Filter Q_ search <Ctrl+K> = | Events < > x
v I ©tccd.edu . . New Message > Activity Manager
& Inbox Thunderbird Mail -_@tccd.edu Attachments Message Filters >
= Trash Edit > Add-ons >
8 Local Folders Email Find " 14 Fitequila g
- Trash Print.. . X
*, Outbox [l Read messages Save A N Lightning >
o ave As % PrintingTools >
7 Wit Folders > o 5
rite a new message
= Empty Trash Message N
Events and Tasks >
[ Accounts ] Tools >
D Bt Hel >
View settings for this account O & —
(“s Setup anaccount:
= Email " Chat ") Newsgroups Feeds
: Create a new calendar
Advanced Features
( :‘\ Search messages
Manage message filters
Manage folder subscriptions
v
@® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X
L] (i) Today Pane v
22. Set up FiltaQuilla as pictured below.
FiltaQuilla preferences % X
Enable all items that you want to have available in the ‘filter rules' dialog. Restart after changes.

"W Filter Actions

| | Search Terms

© About FiltaQuilla / Help

|:| Prepend to Subject

[] Copy As Read

l:] Run Program

[ ]Add Sender to Address List
[ Suffix to Subject

D Remove Tag

[IMark As Unread

l:] Train as Junk

[]Save Attachments To

[ | Detach Attachments To

D Remove Star

[ Mark Replied

D Train As Good

] Javascript Action
[_]save Message as File

[]Do Not Notify

[ ILaunch File

Print

[ ]Javascript Action with Body
[ IMove Later

Cancel
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FiltaQuilla preferences

Enable all items that you want to have available in the ‘filter rules' dialog. Restart after changes.

"W Filter Actions Seanﬁh Terms @ About FiltaQuilla / Help

[IBcc
[IFolder Name

] Header Regex Match
[]Tag of Thread Messages

Subject Regex Match
[ ] Tag of Thread Head

D Javascript

Cancel
23. Click OK to close the FiltaQuilla preferences window.
24. Click Options icon >> Message Filters >> Message Filters.
Home \ B - X
[ Get Messages v /" Write v [ Chat /R Address Book ‘ Tag v Quick Filte Q search <Ctrl+K> = | Events < > X
v I ©tccd.edu New Message > Activity Manager
& Inbox Thunderbird Mail - I G@tccd.edu Attachments [ — >
= Trash Edit Run Filters on Folder N
8 Local Folders Email Find Run Filters on Message N
= Trash Print
Fil >
*, Outbox [, Read messages Save As N e
Id N View >
Folders
-/ Write a new message Empty Trash Go >
- Py Message >
Events and Tasks >
Accounts Tools >
) . X D Exit Hell >
View settings for this account O & =l
(“a Setup anaccount:
= Email ") Chat " Newsgroups Feeds
7] Create a new calendar
Advanced Features
L4, Search messages
Manage message filters
Manage folder subscriptions
v
® Thunderbird now contains calendaring functionality by integrating the Lightning extension. Learn more Disable Keep X
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25. Click New.

0 Message Filters

Filters for: g |l @tccd.edu v Q Search filters by name...

Enabled filters are run automatically in the order shown below. 0 items
Filter Name Enabled
Run selected filter(s) on: | (% Inbox on [N @tc.. Run Now

New... j

Edit...

Delete

Move to Top
Move Up
Move Down

Move to Bottom

Filter Log
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26. Create the filter as pictured below, then click OK.

Filter Rules

Filter name: ’ Auto Print Loan Receipt Letters

Apply filter when:
Manually Run

Getting New Mail: ‘ Filter before Junk Classification ‘
[ Archiving
[ After Sending

(® Match all of the following () Match any of the following () Match all messages

’ Subject b ‘ ‘ contains 2 ‘

Loan Receipt Letter

Perform these actions:

Print

OK

Cancel




27. Make sure your Message Filters screen looks like this (with your campus account information).
If you have received any Loan Receipt Letters, you can click Run Now to test your printer, otherwise,
click the X to close the window.

®) Message Filters — Ol X
Filters for: | g IR ©@tccd.edu v | | Q Search filters by name...
Enabled filters are run automatically in the order shown below. 1 item
Filter Name Enabled New... -
Auto Print Loan Receipt Letters i
Edit...
Delete
Move to Top
Move Up
Move Down
Move to Bottom
Run selected filter(s) on: | * Inbox on NN Gtc... VL\\L Run Now Filter Log

28. Leave Thunderbird running to automatically print incoming Loan Receipt Letters.
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